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1. Introduction

This implementation manual describes how to implement the Clinical Procedures (CP)
application. It also contains setup instructions for Consults/Request Tracking, Text Integration
Utility (TIU), Computerized Patient Record System (CPRS) and commercial off the shelf
(COTY) interfaced devices. All setup instructions and their steps are required for a successful
implementation of the Clinical Procedures package.

Topics discussed in this chapter are:

e About Clinical Procedures

e Related Manuals

e General CP Package Information

e Resource Requirements

e Hospital Location File Requirement

About Clinical Procedures

A clinical procedure is a clinical test where the result is usually obtained from an automated
instrument such as pulmonary function devices, EKGs, ECHOs, EMGs, EEGs, endoscopy and
bronchoscopy instruments, dialysis machines, or other similar COTS devices. CP is a conduit
for passing final patient results, using Health Level 7 (HL7) messaging, between vendor clinical
information systems (CIS) and Veterans Health Information Systems and Technology
Architecture (VistA). The patient’s test result or report is displayed through the Computerized
Patient Record System (CPRS). The report data is stored on the Imaging Redundant Array of
Inexpensive Disks (RAID) and in some instances, discrete data is stored in the Medicine
database.

CP provides features that can be used across clinical departments such as general medicine,
cardiology, pulmonary, women’s health, neurology, and rehabilitation medicine. CP uses the
procedure order function that is included with the Consults/Procedures package. For example, a
clinician places an order for a procedure, such as an EKG, in the Consults/Procedures
application.

If the procedure is performed on a bi-directional instrument, the patient demographics are
automatically transmitted to the instrument. When the procedure is complete, the result is then
transmitted back to VistA. The result is stored in VistA Imaging and associated with a TIU
document. The result and the TIU document are then associated with the original Consults
order.

April 2004 Clinical Procedures V. 1.0 1-1
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If the procedure is performed on a uni-directional instrument, then the clinician must use the CP
User application to match the instrument results to the procedure order. Then the clinician
submits the results to Imaging and creates the TIU document. Once the TIU document is in
place, standard Consults functionality is used to complete and sign the TIU document.

The following pages contain flowcharts explaining the bi-directional and uni-directional Clinical
Procedures process flow.

1-2 Clinical Procedures V. 1.0 April 2004
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Clinical Procedures Bi-Directional Interface Process Flow:

Perform Tell VistA
1. CPRS procedure > Imaging to follow

pathway to result

Y

A

A 4 A 4

Order Procedure Transmit
Request HL7 message 8. VistA
to VistA Imaging

A 4

Procedure request

status = “Pending” 5. CP Mumps - v
Device Interface Copy_ result to
Imaging RAID
' 2. CPUser v
Decode HL7 Notify EP result
Y message & store copied to Imaging
Check-In the result pathway RAID
study : |
v 9. CP Mumps -
Study status = 6. CP Gateway Package Interface
“Pending
Instrument Data” v

‘ Match result to . - .

study Notify Consults results is
ready for interpretation/
3. CP Mumps - signature
Device Interface ¥
g Store result pathway ;

! with study Study status =
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|

Procedure
request status =
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11. CPRS
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Alert interpreting
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Interpreting physician
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Procedure Request
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Y

Alert the ordering
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procedure is complete
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This is a flowchart describing the configuration of Clinical Procedures:
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About CP User

CP User checks in a procedure request for a study. CP User also links the result from the
automated instrument to the procedure ordered through Consults in CPRS. With CP User, if the
device is bi-directional, the clinician manages the results and submits them to the requested
device. The results then are automatically processed by CP Gateway, stored in VistA Imaging,
and are ready for review within Consults. If the instrument is uni-directional, the clinician has to
associate the results and submit them to the VistA Imaging system for storage. These
attachments display under the appropriate TIU document for the original Consults order.

About CP Manager

CP Manager is used to configure the site files, CP INSTRUMENTS, CP PROCEDURES and
required system parameters. It is recommended that access to CP Manager be restricted to users
who manage the CP applications.

About CP Gateway

CP Gateway manages the flow of information from the instrument interfaces to the studies. CP
Gateway polls VistA regularly for new data from instruments and processes this data into usable
attachments for the VistA Imaging system. This module also manages the log files and purges
log file entries.

Intended Audience

The Implementation Guide is intended for use by Clinical Application Coordinators (CAC),
Technical Support Office (TSO), Information Resource Management (IRM), implementation
managers, and Enterprise VistA Support (EVS). Each team member is responsible for different
aspects of the implementation, and then the maintenance of the product.

1-8 Clinical Procedures V. 1.0 April 2004
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Related Manuals
Here is a list of related manuals that you may find helpful:

Clinical Procedures Installation Guide

Clinical Procedures Technical Manual and Package Security Guide
Clinical Procedures User Manual

Clinical Procedures Release Notes

CPRS User Guide: GUI Version

CPRS Setup Guide

Consult/Request Tracking User Manual
Consult/Request Tracking Technical Manual

Text Integration Utilities (TIU) Implementation Guide
Text Integration Utilities (TIU) User Manual

VistA Imaging System (Clinical) User Manual

These manuals can be found in the VistA Documentation Library (VDL),
http://www.va.gov./vdl. Select Clinical from the VDL web page, select the package you want,
and then select the manuals. For example, you can select CPRS on the left side of the page. The
list of CPRS manuals is displayed.

1You may also want to read the CP Implementation Process (Webpage), which is available on
the CP website. Go to http://vista.med.va.gov/ClinicalSpecialties/clinproc/.

Point to Clinical Procedures Project, then click Documentation. When the Documentation
page displays, click Clinical Procedures Documents, then click The CP Implementation
Process (Webpage). This list includes a high-level step-by-step guide to the installation and the
implementation process.

1 MD*1.0*6 May 2008 Changed document name from “Site Installation Checklist” to “The CP Implementation

Process (Webpage).” Revised directions to access the document.

April 2004 Clinical Procedures V. 1.0 1-9
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General CP Package Information

1. Name spacing and file listing.

Clinical Procedures is found in the MD namespace. All routines, templates and options begin
with MD. File numbers range from 702 to 704 and are stored in the MDD and “MDS globals.
The range of 704.201 to 704.209 is stored in the "MDK global. Here is a list of the Clinical
Procedures files:

#702 CP Transaction

#702.01 CP Definition

#702.09 CP Instrument

#703.1  CP Result Report

1#703.9  CP Conversion File

#704.201 Hemodialysis Access Points File
#704.202 Hemodialysis Study File
#704.209 Hemodialysis Setting File

2. Queuing TaskMan jobs.

2Queued TaskMan jobs are associated with this application. Here is a list of options that can be
scheduled:

MD SCHEDULED STUDIES

MD STUDY CHECK-IN

MD PROCESS NOSHOW/CANCEL
MD PROCESS RESULTS

3. Accessing modules.
e Assign the option [MD GUI USER] to the clinical staff, who need access to CP User.

e Assign the option [MD GUI MANAGER] to the Clinical Application Coordinator, CP
package coordinator, and Information Resource Management Service (IRMS) staff for
access to CP Manager.

e Assign the MD MANAGER key to the Clinical Application Coordinator or the CP
Package Coordinator. This key controls access to the Update Study Status menu option
that allows clinicians to fix study errors. This key also controls access to the Delete Study
option.

e Assign the MAGCAP CP user security key to technicians, who will be using VistA
Imaging to capture a consent form and link it to a CP study or TIU document.

! patch MD*1.0*6 May 2008 Files added.

2 patch MD*1.0*20 November 2010 Update queued tasks information.

1-10 Clinical Procedures V. 1.0 April 2004
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4. !Assigning Options:

e Assign the option [MD COORDINATOR] to the Clinical Application Coordinator, CP
package coordinator, and Information Resource Management Service (IRMS) staff for
access to the setup option for the auto study check-in.

e Assign the option [MD PROC W/INCOMPLETE WORKLOAD] to the Clinical
Application Coordinator, CP package coordinator, and Information Resource
Management Service (IRMS) staff to print a list of procedure with incomplete workload.

e Assign the option [MD STUDIES LIST] to the Clinical Application Coordinator, CP
package coordinator, and Information Resource Management Service (IRMS) staff to
print a list of studies list.

The screen captures below demonstrate how to assign an option to a user:

» Use the [XUSER] User Management menu option.

Select OPTION NAME: XUSER

1 XUSER User Management
2 XUSER DIV CHG Change my Division
3 XUSER FILE MGR Manage User File
4  XUSER KEY RE-INDEX Reindex the users key"s
5  XUSER PC BUILD User PC build Print
Press <RETURN> to see more, "~" to exit this list, OR
CHOOSE 1-5: 1 XUSER User Management

» Select [XUSEREDIT] Edit An Existing User option.

Select User Management Option: ?

Add a New User to the System
Grant Access by Profile

Edit an Existing User

Deactivate a User

Reactivate a User

List users

User Inquiry

Switch ldentities

File Access Security ...

Clear Electronic signature code
Electronic Signature Block Edit
Manage User File ...

OAA Trainee Registration Menu ...
Person Class Edit

Reprint Access agreement letter
Select User Management Option: EDit an Existing User

! patch MD*1.0*21 May 2010 — Updated General CP Package Information to add Assigning Options for options
released with patch 21 and previous patches.

April 2004 Clinical Procedures V. 1.0 1-11
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» Select the user.

Select User Management Option: EDit an
Select NEW PERSON NAME: TEST

1 TEST,A TA

2 TEST,CARL TC P
3 TEST,CAROLE CJT 1SC
4  TEST,FRANCE FT

5 TEST,KEN RADI

Existing User

HYSICIAN
COMPUTER SPECIALIST

OLOGIST

Press <RETURN> to see more, "~" to exit this list, OR

CHOOSE 1-5: 1 TEST,A TA

» Enter the option name, MD COORDINATOR, to the Select SECONDARY MENU

OPTIONS: ield.

Edit an Existing User

NAME: TEST,A

Page 1 of 5

NAME. .. TEST,A
TITLE:
SSN: 666435465
DEGREE:
DISUSER:
Termination Reason:

PRIMARY MENU OPTION:
Select SECONDARY MENU OPTIONS: MD COO

Want to edit ACCESS CODE (Y/N):

Want to edit VERIFY CODE (Y/N):

Select DIVISION:
SERVICE/SECTION: IRM FI1

INITIAL: TA
NICK NAME:
DOB:
MAIL CODE:
TERMINATION DATE:

RDINATOR
FILE MANAGER ACCESS CODE:

ELD OFFICE

High Volume Procedure Setup
Are you adding "MD COORDINATOR" as

a new SECONDARY MENU OPTIONS (the 1ST for this NEW PERSON)? No// Y

» Verify the SECONDARY MENU OPTIONS field has the option name MD

COORDINATOR and enter a four characters SYNONYM for the option name.

Edit an Existing User

NAME: TEST,A

Page 1 of 5

NAME. .. TEST,A
TITLE:
SSN: 666435465
DEGREE:
DISUSER:
Termination Reason:

INITIAL: TA
NICK NAME:
DOB:
MAIL CODE:
TERMINATION DATE:

Select
Want to
Want to SECONDARY MENU OPTIONS: MD C
SYNONYM: COOR

SECONDARY MENU OPTIONS

OORDINATOR |

COMMAND :

1-12 Clini
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» Enter additional SECONDARY MENU OPTIONS.

Edit an Existing User

NAME: TEST,A Page 1 of 5
NAME. .. TEST,A INITIAL: TA
TITLE: NICK NAME:
SSN: 666435465 DOB:
DEGREE: MAIL CODE:
DISUSER: TERMINATION DATE:

Termination Reason:

PRIMARY MENU OPTION:

Select SECONDARY MENU OPTIONS:
Want to edit ACCESS CODE (Y/N): FILE MANAGER ACCESS CODE:

Want to edit VERIFY CODE (Y/N):

Select DIVISION:
SERVICE/SECTION: IRM FIELD OFFICE

COMMAND : Press <PF1>H for help Insert

»When you are finished, enter “SAVE” at the COMMAND field to save the data and enter
“EXIT” to exit the editor.

COMMAND: SAVE Press <PF1>H for help Insert

COMMAND: EXIT Press <PF1>H for help Insert

» Once the option(s) are added, the person can enter “??” at the primary menu option to get a
listing of the secondary menu option and can see the new added option(s).

Select Core Applications Option: ??
You can also select a secondary option:

AUTO  Auto Study Check-In Setup [MD AUTO CHECK-IN SETUP]

Gl Gl Menu ... [MCARGIUSER]

HEVD CM Troubleshooter Clinician ... [ORRCMM TROUBLESHOOTER CLIN]

COOR  CP Coordinator Menu ... [MD COORDINATOR]

LIST Clinical Procedures Studies List [MD STUDIES LIST]

MAGS Imaging System Manager Menu ... [MAG SYS MENU]

**> Locked with MAG SYSTEM

PFT Pulmonary Menu ... [MCARPULMUSER]

RA Rad/Nuc Med Total System Menu ... [RA OVERALL]

TIU TIU Maintenance Menu ... [TIU IRM MAINTENANCE MENU]

WKLD Print list of Procedure with incomplete workload [MD PROC W/INCOMPLETE
WORKLOAD]

5. Printer issues.

All reports are printed to Client (Windows) printers.
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6. Online Help.

Online help is available when questions arise. Click Help or choose Help from the menu bar.
You can also press F1 for help on a specific window.

7. Automatic Version Updates.

CP applications (client and server) do not contain automatic update capabilities. You must
remove the previous version before you can install the new version.

8. Command line switches.

For alternate methods of running Clinical Procedures, refer to Appendix A - CP Application
Startup Options and Command Line Switches, p. 10-6.

Resource Requirements
e Clinical Procedures can only run at sites that are running VistA Imaging V. 3.0.

e Workstations must run Windows 2000 or later. 12 MB of available disc space is
required.

VistA Server resources:

Globals Type of Data Size
AMDS Static global 25k
MDD Patient data for the 25-75 k/patient
Clinical Procedures
AMDK Hemodialysis Studies 25-75 k/patient
NOTE: These globals must all be journalled.
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Hospital Location File Requirement (Implementing Workload
Reporting)

Be sure that the hospital location entry (Hospital Location #44 file) for each CP procedure
contains the correct Institution field entry. The Hospital Location is used for workload
reporting. (The Institution field tells VistA Imaging where to store the images on the server. If
there is no Institution field, CP defaults to the institution of the user who logged on to CP
Gateway.)

VistA Imaging
Providers at a site must use the VistA Imaging Display client to view CP results and reports. Be

sure that VistA Imaging V.3.0 or greater and Patch 7 of Imaging V.3.0 (MAG*3.0*7) are
installed.
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2. Using CP Manager
This chapter describes how to use CP Manager.
Topics discussed in this chapter are:

e CP Manager Toolbar

e Finding a Parameter

e Deleting an Automated Instrument or Procedure
e Printing Reports

CP Manager Toolbar

Here is a list of icon descriptions:

= New Instrument - Creates a new instrument.

New Procedure - Creates a new procedure.

Ep -
Make a Copy of the Selected Item — Creates a copy of the selected instrument or procedure.

“* Undo Changes - Cancels changes made since that last save to the current screen.

B save - saves changes made to current screen.

x.

Delete - Deletes an instrument or procedure.

iy

Print a Report - Prints reports listing instruments, procedures, or system parameters.

Q Find a Parameter - Finds an instrument or procedure.

0101
1101

“iir Calculate a File’s CRC Value - Calculates a file’s CRC (Cyclical Redundancy Check)
value.

i Instrument Analyzer - Indicates whether an instrument is ready for use or not and why.

April 2004 Clinical Procedures V. 1.0 2-1
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* Refresh - Refreshes the parameter listing on the left side of the Clinical Procedures
Manager screen.

7 Help - Provides online help for this package.

& Clinical Procedures Home Page - Goes to the Clinical Procedures Home Page on the Web.

Finding a Parameter

Use this option when you want to find a specific automated instrument or procedure.

1. Select Tools > Find a Parameter.
2. Enter a partial or complete name of the instrument or procedure.
3. Click OK to begin the search.
4. 1f you find the parameter that you are searching for, click Yes on the confirmation
window. The edit window for the parameter is displayed.
2-2 Clinical Procedures V. 1.0 April 2004
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Deleting an Automated Instrument or Procedure

You may want to delete an instrument or a procedure that you are no longer using at your site.
Before you delete an instrument or procedure, be sure that the CP procedure is not linked to a
Consult procedure. (You cannot delete a procedure that is linked to Consults.) If you already
used the CP procedure, then it is already linked to Consults. If the CP procedure is associated
with a consult procedure, you must remove the links before you can delete the procedure.

To ensure that the links are removed, you can use FileMan to view the CP Definition file. If the
CONSULT PROCEDURE column of the report is empty, then you know that there aren’t any
Consults/Procedure entries pointing to the definition. Here’s an example of the report:

Using FileMan, do the following...
Select OPTION: 2 PRINT FILE ENTRIES

OUTPUT FROM WHAT FILE: CP DEFINITION
SORT BY: NAME// <Ret>
START WITH NAME: FIRST// <Ret>
FIRST PRINT FIELD: .01;L30;"CP DEFINITION"
THEN PRINT FIELD: GMRC PROCEDURE:
By "GMRC PROCEDURE®, do you mean the GMRC PROCEDURE File,
pointing via its "CLINICAL PROCEDURE" Field ("AC" Cross-reference)? Yes// Y

THEN PRINT GMRC PROCEDURE FIELD: .01;L30;"CONSULT PROCEDURE"

THEN PRINT GMRC PROCEDURE FIELD: <Ret>
THEN PRINT FIELD: <Ret>
Heading (S/C): CP DEFINITION LIST// CP DEFINITIONS AND RELATED CONSULT PROCEDURES
STORE PRINT LOGIC IN TEMPLATE: <Ret>

DEVICE: HOME
CP DEFINITIONS AND RELATED CONSULT PROCEDURES FEB 6,2004 09:12 PAGE 1
CP DEFINITION CONSULT PROCEDURE

ANO SINGLE TUMOR (HOT/BICAP)

ANOSCOPY

ARRHYTHMIA INDUCTION BY PACING ARRYTHMIA

ARTERIAL BLOOD GASES

ARTERIAL CANNULATION

ARTERIAL PUNCTURE

BIOPSY LUNG, PERCUTANEOUS NDL

BIOPSY, PLEURA

BONE MARROW BONE MARROW ASPIRATE

BONE MARROW INTERPRETATION BONE MARROW BIOPSY
BONE MARROW ASSESSMENT

BRONC DIAGNOSTIC W/BAL

BRONC W/BRONC WASHING BRONCHOSCOPY

BRONC W/TRANSBRONC LUNG BX

BRONCHOSCOPY, LASER

BRONCHOSCOPY, STENT PLACEMENT

After you have determined that the CP procedure is not linked to Consults, follow these steps to
delete.

1. Use the GMRC MGR menu option. Under the Setup Procedure option, delete the CP
procedure from the CLINICAL PROCEDURE field.

Logon to CP Manager.

Display the list of automated instruments or procedures on the CP Manager window.
4. Click the name of the instrument or procedure that you want to delete.

wn
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5.

Select File > Delete.

6. Click Yes to confirm the deletion.

Printing Reports

You can print a listing of automated instruments, procedures, or system parameters. You can

also print a detailed report of a selected instrument or procedure.

To print a list of instruments, procedures or system parameters, do the following:

1.
2.

3.

Select File > Print.

Select Automated Instruments, Procedures, or System Parameters. If you previously
selected a specific instrument or procedure, you can also select that instrument or

procedure name.
Click OK to print.

To print a report of a selected instrument or procedure:

1.
2.
3.

4.

Example of an Automated Instruments report:

Select the instrument or procedure name.

Select File > Print.

From the list of available reports, select the procedure or instrument. You may have to

enter a report title.
Click OK to print.

Automated Instruments

Printed: 7/10/03 3:34:21 PM

NAME PRINT NAME SERIAL # M RTN PKG ACTIVE
CLINIVISION Clinivision CL58374 MDHL7R1 CP V1.0 No

MUSE Muse M8372J32 MDHL7M1 CP V1.0 Yes

MUSE EKG Muse EKG M8372J2 MDHL7M1 CP V1.0 Yes

OLYMPUS Olympus 046237A MDHL7E CP V1.0 Yes

OLYMPUS EGD Olympus EGD 046237A MDHL7E CP V1.0 Yes

[End of Report]

Clinical Procedures V1.0 Page: 1
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Example of a Procedures report:

Using CP Manager

Procedures Printed: 7/10/03 3:34:30 PM
NAME TREATING SPECIALTY TIU NOTE LOCATION ACTIVE EXT DATA
BIOPSY LUNG PULMONARY PULMONARY NOTE PULMONARY CLINIC No No

ECHO CARDIOLOGY CARDIOLOGY NOTE  CARDIOLOGY CLINIC Yes Yes

EGD DIAGNOSTIC GASTROENTEROLOGY EGD NOTE Gl LAB Yes Yes
HOLTER CARDIOLOGY CARDIOLOGY NOTE  CARDIOLOGY CLINIC Yes No
PACEMAKER FOLLOWUP CARDIOLOGY CARDIOLOGY NOTE  CARDIOLOGY CLINIC Yes Yes

[End of Report]

Clinical Procedures V1.0 Page: 1

Example of a System Parameters report:

System Parameters

Printed: 7/10/03 3:34:40 PM

System Parameters For: DEV_DEV.FO-HINES.MED.VA.GOV

Parameter: MD ALLOW EXTERNAL ATTACHMENTS Type: yes/no
Description: Allow non-instrument attachments Multiple: No
Value: NO
Parameter: MD CRC BYPASS Type: yes/no
Description: Bypass CRC Checking Multiple: No
Value: YES
Parameter: MD CRC VALUES Type: free text
Description: Clinical Procedures CRC Values Multiple: Yes
Values:
CPGATEWAY.EXE.1.0.0.20 = ODCE4C31
CPGATEWAY.EXE.1.0.0.21 = ODCE4C31
CPMANAGER.EXE.1.0.0.20 = CB12FEEO
CPMANAGER.EXE.1.0.0.21 = CB12FEEO
CPUSER.EXE.1.0.0.20 = B819E183
CPUSER.EXE.1.0.0.21 = B819E183
Parameter: MD DAYS FOR INSTRUMENT DATA Type: numeric
Description: Temporary instrument data life (Days) Multiple: No
Value: 2
Parameter: MD FILE EXTENSIONS Type: free text
Description: Imaging File Types Multiple: Yes
Values:
_bmp = Bitmap Images
.doc = MS Word files
_html = Hypertext Markup Language files
-jpeg = JPEG Images
-Jpg = JPEG Images
_pdf = Portable Document Format
.rtf = Rich text files
_tiff = TIFF Graphics
_txt = Text files
Parameter: MD HFS SCRATCH Type: free text
Description: VistA Scratch HFS Directory Multiple: No
Value: USER$:[HFS]
Parameter: MD IMAGING XFER Type: free text
Description: Imaging Network Share Multiple: No
Value: \\Ish-imaging\Uploads
Parameter: MD OFFLINE MESSAGE Type: word processing
Description: Offline message Multiple: No
WP-Text:
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Parameter: MD ONLINE Type:
Description: Clinical Procedure Online/Offline Multiple:
Value: YES

Parameter: MD VERSION CHK Type:
Description: Version Compatibility Multiple:

Values:

CPGATEWAY.EXE.1.0.0.20 = YES

CPGATEWAY.EXE.1.0.0.21 = YES

CPMANAGER.EXE.1.0.0.20 = YES

CPMANAGER.EXE.1.0.0.21 = YES

CPUSER.EXE.1.0.0.20 = YES

CPUSER.EXE.1.0.0.21 = YES
Parameter: MD WEBLINK Type:
Description: Clinical Procedures Home Page Multiple:

Value:

vista.med.va.gov/ClinicalSpecialties/clinproc/

[End of Report]

yes/no
No

YES/NO
Yes

free text

No

Clinical Procedures V1.0

Page: 1

Example of a report for an individual automated instrument:

Instrument - Muse EKG

Printed: 7/10/03 3:34:51 PM

Instrument Name: Muse EKG

Notification Mailgroup:
Description:

Delete when submitted:
Printable Name:
Default Ext.:
Serial Number:
Active:

M Routine:

Pkg Code:
Bi-Directional
IP Address:
Port:

HL7 Inst ID:
HL7 Unv Svc
HL7 Link:
Server Name:
Share Name:
Path Name:
Executable Name:
UNC:

Text:

URL:

DLL:

UUEncode:

XML :

XMS:

[End of Report]

Instrument:

I1D:

MD DEVICE ERRORS
Muse EKG Device Interface

<Blank>

Muse EKG

<Blank>
M8372J2
Yes
MDHL7M1
CP V1.0
Yes

10.3.25.28

9300

Muse EKG
93000=EKG
MCAR OUT

<Blank>
<Blank>
<Blank>
<Blank>
<Blank>
<Blank>
<Blank>
<Blank>
Yes

<Blank>
<Blank>

Clinical Procedures V1.0

Page: 1
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Example of a report for an individual procedure:

Using CP Manager

Procedure - ECHO

Printed: 7/10/03 3:35:02 PM

Procedure Name: ECHO

Treating Specialty:

Require External Data:

TIU Note Title:

Hospital Location:

Auto Submit to VistA Imaging:
External Attachment Directory:
Active:

Associated Instruments:

MUSE
[End of Report]

CARDIOLOGY

Yes

CARDIOLOGY NOTE

CARDIOLOGY CLINIC

Yes, Submit to VistA Imaging
/CARDPATH

Yes

Clinical Procedures V1.0

Page: 1
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3. About Test Accounts and Imaging

This section explains how to prevent Imaging System conflicts at sites where a mirror of a VistA
account has been created for test purposes. Be sure to follow the instructions in this section
before you add any new images to the test account. These steps are required.

Note: This section assumes that the test account has already been created.

Caution: The changes described in this section are intended for test accounts only. Making these
changes in a production account can compromise the Imaging database and could result in the
loss of patient data.

Topics discussed in this chapter are:

e Changing All Test Accounts

e Changing Test Accounts that Use a Background Processor
e Connecting the PC to VistA Servers

e Refreshing Existing Test Accounts
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Changing All Test Accounts

For all test accounts, you must change the current namespace and set the imaging network
location operational status.

Caution: The changes described in this section are intended for test accounts only. Making
these changes in a production account can compromise the Imaging database and may result in
the loss of patient data.

Changing the Current Namespace

You must change the value of Current Namespace (2006.1, .02) to prevent test images from
mixing with and in some cases overwriting actual patient images. Using VA FileMan, change
the Current Namespace field in the IMAGING SITE PARAMETERS file to ZZ as follows:

DVA>D PADI
VA FileMan 22.0
Select OPTION: ENTER OR EDIT FILE ENTRIES
INPUT TO WHAT FILE: IMAGING SITE PARAMETERS// 2006.1 [IMAGING SITE
PARAMETERS
(1 entry)

EDIT WHICH FIELD: ALL// .02 CURRENT NAMESPACE
THEN EDIT FIELD: <enter>

Select IMAGING SITE PARAMETERS NAME: 1 IMGDEMO1l.MED.VA.GOV
CURRENT NAMESPACE: AB// ZZ

Select IMAGING SITE PARAMETERS NAME:

Note: If you have more than one million entries in the Imaging file (2005), use a single character
for the namespace, such as Z.

After this change is made, the first image captured to the test account creates the ZZ directory on
the VistA Imaging file servers. All test account images are stored in the ZZ directory and
include the ZZ prefix in their file names such as, ZZ2123456.tga.

Note: For test accounts at multi-divisional sites that are running the VistA Imaging
“Consolidated Code,” you must modify the Current Namespace field for each division defined in
the file. Make the value for each instance of Current Namespace unique, such as ZX, ZY, or ZZ.

3-2 Clinical Procedures V. 1.0 April 2004
Implementation Guide



About Test Accounts and Imaging

Setting the Imaging Network Location Status

Be sure the Imaging Network Location status for the test account is set to “online”. There is an
option on the Background Processor that lets you view each network and changes its status.
Select Edit > Network Location Manager (Figure 3-1), and then select the Online Status
checkbox (Figure 3-2).

#7 ¥ista Imaging Background Processor - 4:36:12 PM WsID: OB ID: =0 x|
File | Edt Wiew Help
 Add[Remove BP Workstations ¥ista Magnetic Cache
T EP Workstation Parameters =1l @ Sstant @ Stop I
Purae Paramebars r |[IEM |FreeSpace DiskSize SharePath i| |
Quese Managar ]

Imaging Site Paramesbers

<11
1 Lr‘ Tasks

Background Processor Event Log

Event Time PROCESS:QUEUE |Process Status A

Figure 3-1
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% Network Cache Manager ISW

Space Liilization in Gigabytes

=10 x|

M 63 Free Space
W 10 Uszed Space

Uzed Space

—LCache D
Starage Type
Share Mame |M;‘-‘«G1H & Falm
 JUKEBD:
Metwark Path |HhISW-IMGGDLDhIMﬂGE1$h " EKG
C GCC

—Muze/Haouter Security

Ilzer Mame I

Paszward I

[+ Orline Status

¥ Hashed Wiy Stictune
[T Routing Share

V’ ok | x Cancel | ? Help |

Figure 3-2
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Configuring the Imaging Display Station

When the Imaging Display Station wants to use the test account, the station needs to know the
name and port number of the account. Run MAGSYS.EXE to edit the MAG.INI file. For the
procedure, refer to the Imaging System Installation Guide, V. 3.0.
(http://vaww.va.gov/imaging/IMGinstallgd.pdf)
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Changing Test Accounts that Use a Background Processor

If a Background Processor is needed for the test account, you must make the following changes:

1. Delete test account entries in the Background Processor Queue files. You need to delete the

3-6

entries to keep the test Background Processor from reprocessing tasks left over from the
production account. Use VA FileMan to delete all entries in the following two files:

IMAGE BACKGROUND QUEUE file (2006.03)
IMAGE BACKGROUND QUEUE POINTER file (2006.031)

Caution: Only perform these steps on a test account. Use extreme caution when deleting all
entries in a file.

DVA>D P~ADI
VA FileMan 22.0
Select OPTION: ENTER OR EDIT FILE ENTRIES

INPUT TO WHAT FILE: IMAGE BACKGROUND QUEUE// 2006.03 IMAGE BACKGROUND
QUEUE
(6543 entries)
EDIT WHICH FIELD: ALL// .01///0@
WARNING: THIS MEANS AUTOMATIC DELETION!T QUEUE NAME
THEN EDIT FIELD: <enter>

Select IMAGE BACKGROUND QUEUE QUEUE NAME: ~LOOP
EDIT ENTRIES BY: QUEUE NAME// <enter>
START WITH QUEUE NAME: FIRST// <enter>

JUKEBOX

JUKEBOX

JUKEBOX

JUKEBOX
LOOP ENDED!

Select IMAGE BACKGROUND QUEUE QUEUE NAME: ~
Select OPTION: ENTER OR EDIT FILE ENTRIES

INPUT TO WHAT FILE: IMAGE BACKGROUND QUEUE// 2006.031 IMAGE BACKGROUND
QUEUE
POINTER (5 entries)
EDIT WHICH FIELD: ALL// .01///0
WARNING: THIS MEANS AUTOMATIC DELETION!! QUEUE NAME
THEN EDIT FIELD: <enter>

Select IMAGE BACKGROUND QUEUE POINTER QUEUE NAME: ~LOOP
EDIT ENTRIES BY: QUEUE NAME// <enter>
START WITH QUEUE NAME: FIRST// <enter>

ABSTRACT
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GCC
IMPORT
JBTOHD
JUKEBOX
LOOP ENDED!

Select IMAGE BACKGROUND QUEUE POINTER QUEUE NAME:

2. Configure the Background Processor being used in the test account to process only the
ABSTRACTS and IMPORT queues. Turn off all other queue processing. Use the BP
Workstation Parameters option to configure queue processing.

a. From the Background Processor, choose Edit > BP Workstation Parameters.

b. If there are multiple Background Processors listed in the top dialog, select the one that is
being used for the test account.

c. Ensure that only the options shown below are selected.

#1* Background Process - O] x|

Background Proceszar Wark Stations

ELS ISW-CASLIGAYE

— Backaground Processar Activity—
v Background Processar
[ Abstract

[ Jukebox
[ JETOHD
[ Delete

[~ Prefetch

[ Aute 'Wiite Location Update

Figure 3-3
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d. When you are finished, close the dialog.

Note: If you need to test the JUKEBOX, JBTOHD, or GCC queue-processing functions,
you need to add new entries to the Network Locations file (2005.2) to prevent conflicts
with the with the production account. For assistance, contact the VistA Imaging support
team.

Caution: Using the DELETE queue processing function on a test account can lead to the
deletion of image files on the production account. If it is necessary to use the DELETE
queue processing function in the test account, contact the VistA Imaging support team.

3. Decide if you want to setup the test Background Processor on its own PC, or as a second
instance on the same PC with the existing Background Processor. If you plan to setup the
test and production Background Processor on the same PC, go to the next section,
Connecting the PC to VistA Servers.
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Connecting the Background Processor PC to VistA Servers

If both a test and production Background processor are running on the same PC, you need to
connect the PC to the VistA production server and test server. You make this connection by
editing the Windows Registry. If DNS or WINS cannot resolve the computer names entered in
the registry, you will need to make further changes in the PC’s HOSTS file.

1. Registry Changes
Add the “string value” for each VistA Server to the Registry key and use the following
syntax:
< VistA Server name>,<Broker port> (i.e. VistA -Live,9200)
HKEY_LOCALMACHINE\Software\Broker\Servers registry key.

Sample entries are shown below.

&' Registry Editor =10l x|
Registry Edit  Wiew Favorites Help
= = My Computer | | Mame Tvpe | Data
D HKEY_CLASSES_ROOT (Default) REG_SZ (value nat set)
{:l HKEY _CURREMNT_LISER 'u'lst REG_SZ
E|{:| HKEY _LOZAL_MACHIMNE 'u'lst REG 57
! -] HARDWARE -

¢ e 5Am

© {7 SECURITY

-] SOFTWARE

H-{] Adaptec
-0 Adobe
&1 analog Devices

Figure 3-4
You can edit the Registry with ServerList.exe (a utility distributed with the RPC Broker

development toolkit) or manually with regedit.exe. See the RPC Broker System Guide for
more detailed information on using ServerList.exe to edit the registry.

Caution: Use extreme caution when editing the registry manually. Improper changes can
leave your system unstable or non-functional. The VA recommends that you edit the registry
with ServerList.exe.
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2. Editing the HOSTS File

If your site cannot use DNS or WINS to resolve the names added to the registry, you need to

create entries in your HOSTS file for each entry added to the registry. A sample HOSTS is
shown below.

#HOSTS file

152.128.12.44 VistA-Live BROKERSERVER
DHCPSERVER

152.128.11.23 VistA-Test

#END

The HOSTS file has no file extension. It is located in WINNT\SYSTEM32\DRIVERS\ETC.

Refreshing Existing Test Accounts

When a test account is refreshed with a copy of a production account, be sure to repeat the
following steps:

e Changing the Current Namespace.
e Deleting test account entries in the Background Processor Queue files.

e Configure the Background Processor used in the Test Account. See Connecting the PC
to VistA Servers, p. 3-9.

Also, be sure to manually delete the ZZ folder on the VistA Imaging file servers.
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4. Setting Up TIU for Clinical Procedures

This chapter describes the steps to follow to set up TIU for CP. The purpose of setting up TIU is
to design the CP document hierarchy that creates the TIU document title, which is displayed to
an authorized “Interpreter.” The procedures in this section describe how to configure the new
Clinical Procedures Class in TIU. Be sure to follow these steps in sequential order.

Topics discussed in this chapter are:
e Step 1 — Verify Clinical Procedures Class Upload Header

e Step 2 — Create CP Class Document Definitions
e Step 3 — Define Clinical Procedures Class Document Parameters

Note: Be sure the TIU Enhancement for Clinical Procedures patch (TIU*1*109) is installed
before you set up TIU.
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Step 1 - Verify Clinical Procedures Class Upload Header

The Upload Utility option displays information about how headers are formatted for dictated
documents, which are transcribed offline and uploaded into VistA. This option also displays
"blank™ character, major delimiter and end of message signal as defined by your site. If the
Clinical Procedure CLASS output does not match Figure 4-1, check to see if the TIU*1.0*109
patch was installed. The upload header for the Clinical Procedures Class is automatically set up

when the TIU*1.0*109 patch is installed.

! To verify that the upload header is appropriately defined for the Clinical Procedures Class, use
the option [TIU UPLOAD HELP]. The output will look something like this:

Upload Utility: Access the following option:
Help for Upload Utility [TIU UPLOAD HELP]

Select DOCUMENT DEFINITION: CLINICAL PROCEDURES CLASS

$HDR:

TITLE:

SSN:

VISIT/EVENT DATE:

AUTHOR:

DATE/TIME OF DICTATION:
LOCATION:

EXPECTED COSIGNER:
CONSULT REQUEST NUMBER:
TIU DOCUMENT NUMBER:

DATE/TIME PERFORMED:
$TXT
CLINICAL PROCEDURES Text

CLINICAL PROCEDURES
GENERAL PROCEDURE
666-12-1234
5/15/2001@08:15
CPRSPROVIDER,ONE
5/16/2001@09:25
MEDICAL-CONSULT 6200
CPRSPROVIDER, TWO
1455

543

PROCEDURE SUMMARY CODE: Normal

5/15/2001@08:00

*** File should be ASCII with width no greater than 80 columns.
*** Use "@@@" for "BLANKS" (word or phrase in dictation that isn't understood).

Figure 4-1

! patch MD*1.0*14 March 2008 Output display changed.
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Step 2 - Create CP Class Document Definitions

You need to create CP document classes and titles. A Document Definition provides the
building blocks for the TIU package. A Document Definition organizes a document into a
hierarchical structure. This structure allows documents to inherit characteristics such as
signature requirements and print characteristics from the higher levels, including Class and
Document Class. A Document Definition also lets you create and use boilerplate text, embedded
objects, and CPRS templates.

Types of Class Document Definitions:

CL Class — Main class of documents, such as Clinical Procedures.

DC Document Class — Categories of documents with related characteristics, such as CP
Cardiology, CP Gl.

TL Title — TIU note title, such as CP EKG.

To implement Clinical Procedures, your facility must set up new document definitions for the
Clinical Procedures Class within TIU.

The CLINICAL PROCEDURES CLASS is installed with patch TIU*1.0*109 and is
automatically set to Active.

It is strongly recommended that you create Clinical Procedures Titles and Document
Classes with the “CP” prefix. This will avoid confusion with previously created Titles and
Document Classes. Only documents under the CP class have the CP functionality.

To construct a new document definition sub-tree for Clinical Procedures, do the following:

1. Go into the TIU IRM Maintenance menu.
2. Select Document Definitions Manager > Create Document Definitions.
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A screen similar to the following is displayed. (An example of the hierarchy is shown here. On
your screen, the levels under Clinical Procedures will not show):

Create Document Definitions May 07, 2003@09:03:57 Page: 1of 1
BASICS
Name Type
1 CLINICAL DOCUMENTS CL
2 DISCHARGE SUMMARY CL
3 PROGRESS NOTES CL
4 ADDENDUM DC
5 CLINICAL PROCEDURES CL
6 CP CARDIOLOGY DC
7 CP PULMONARY FUNCTION TEST TL
8 CP EKG TL
9 CP GI TESTS DC
10 CP ENDOSCOPY TL
11 CP COLONOSCOPY TL
12 CP HEMATOLOGY DC
13 CP BONE MARROW TL
14 CP RHEUMATOLOGY DC
?Help >Scroll Right PS/PL Print Scrn/List +/- >>>
(Title) Restart Status. ..
(Component) Boilerplate Text Delete

Select Action: Next Level//

The above example suggests a Service oriented set of Document Classes with one or more Titles
under each. You need to work with your Clinical Application Coordinator (CAC), IRMS, and
the Consulting Services to develop a complete set of Document Definitions for Clinical
Procedures.

To view a list of already existing titles, use the Next Level option to expand the class you want
to view.

You may have to navigate down the hierarchy to add Document Classes or Titles. The following
are examples of going to other levels, creating a document class, and creating a title.
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Example of going to the next level:

Create Document Definitions May 07, 2003@09:03:57 Page: 1of 1
BASICS
Name Type
1 CLINICAL DOCUMENTS CL
2 DISCHARGE SUMMARY CL
3 PROGRESS NOTES CL
4 ADDENDUM DC
5 CLINICAL PROCEDURES CL
?Help  >Scroll Right PS/PL Print Scrn/List +/- >>>

(Title) Restart Status. ..

(Component) Boilerplate Text Delete
Select Action: Next Level// <RET> Next Level
Select CLINICAL DOCUMENTS Item (Line 2-5): 5........... (Clinical Procedures
level)
Create Document Definitions May 07, 2003@09:03:57 Page: 1o0of 1

BASICS
Name Type
1 CLINICAL DOCUMENTS CL
2 DISCHARGE SUMMARY CL
3 PROGRESS NOTES CL
4 ADDENDUM DC
5 CLINICAL PROCEDURES CL
6 CP CARDIOLOGY DC
7 CP GI TESTS DC
8 CP HEMATOLOGY DC
9 CP RHEUMATOLOGY DC
?Help >Scroll Right PS/PL Print Scrn/List +/- >>>

(Title) Restart Status. ..

(Component) Boilerplate Text Delete
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Example of creating a Document Class:

Select ACTION: CLASS Class/DocumentClass

OGY

Enter the Name of a new CLINICAL PROCEDURES: CP NEUROL
TYPE: (CL/DC): DC DOCUMENT CLASS
CLASS OWNER: CLINICAL COORDINATOR Replace  <RET>
STATUS: (A/1): INACTIVE// A ACTIVE
SEQUENCE: <RET>
MNEMONIC: <RET>
MENU TEXT: CP Neurology// <RET>
Entry Created
Create Document Definitions May 07, 2003@09:03:57
BASICS
Name
1 CLINICAL DOCUMENTS
2 DISCHARGE SUMMARY
3 PROGRESS NOTES
4 ADDENDUM
5 CLINICAL PROCEDURES
6 CP CARDIOLOGY
7 CP GI TESTS
8 CP HEMATOLOGY
9 CP RHEUMATOLOGY
10 CP NEUROLOGY

(Title) Restart Status
(Component) Boilerplate Text Delete
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Example of creating a Title:

You must go to the appropriate level before a Title can be added.

Select Action: Next Level// <RET> Next Level

Select CLINICAL DOCUMENTS Item (Line 6-10): 10........... (CP NEUROLOGY
level)
Create Document Definitions May 07, 2003@09:03:57 Page: 1of 1
BASICS
+ Name Type
2 CLINICAL PROCEDURES CL
3 CP NEUROLOGY DC
?Help >Scroll Right PS/PL Print Scrn/List +/- >>>
(Class/DocumentClass) Next Level Detailed Display/Edit
Title Restart Status. ..
(Component) Boilerplate Text Delete

At this point a Title may be added.

Select Action: Title// Title

Enter the Name of a new NEUROLOGY: CP PSEUDOFOLLICULAR SCAN

CLASS OWNER: CLINICAL COORDINATOR Replace  <RET>

1EVERY Local Title must be mapped to a VHA Enterprise Standard Title.
(See example in the following section: “Example of New TIU Prompts™)

STATUS: (AZ1/T): INACTIVE// A ACTIVE

SEQUENCE: <RET>

MENU TEXT: CP Pseudofollicular Scan Replace <RET>

Entry Created

IT you wish, you may enter another CP NEUROLOGY

Create Document Definitions May 07, 2003@09:03:57 Page: 1of 1
BASICS
+ Name Type
2 CLINICAL PROCEDURES CL
3 CP NEUROLOGY DC
4 CP PSEUDOFOLLICULAR SCAN TL
?Help >Scroll Right PS/PL Print Scrn/List +/- >>>
(Title) Restart Status. ..
(Component) Boilerplate Text Delete

! patch MD*1.0*14 March 2008 New prompts added.
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Select Action: Next Level//

'Example of New TIU Prompts
Several new TIU prompts display as each word of the new TIU note title is run through a series
of checks against the national list.

In the following example, the name of the new TIU note title is “CP HEMOTEST.”

EVERY Local Title must be mapped to a VHA Enterprise Standard Title.

Remember, your LOCAL title is: CP HEMOTEST
Attempting to map CP HEMOTEST
to a VHA Enterprise Standard Title...

Is "CP" a Subject Matter Domain? No.
Is "CP" a SYNONYM for a Subject Matter Domain? No.

Is "HEMOTEST" a Subject Matter Domain? No.
Is "HEMOTEST" a SYNONYM for a Subject Matter Domain? No.

Is "CP" a LOINC Role? No.
Is "CP" a SYNONYM for a LOINC Role? No.

Is "HEMOTEST™ a LOINC Role? No.
Is "HEMOTEST™ a SYNONYM for a LOINC Role? No.

Is "CP" a Setting? No.
Is "CP" a SYNONYM for a Setting? No.

Is "HEMOTEST" a Setting? No.
Is "HEMOTEST" a SYNONYM for a Setting? No.

Remember, your LOCAL title is: CP HEMOTEST
Is "CP" a Service? No.
Is "CP" a SYNONYM for a Service? No.

Is "HEMOTEST" a Service? No.
Is "HEMOTEST"™ a SYNONYM for a Service? No.

Is "CP'" a Document Type? No.
Is "CP" a SYNONYM for a Document Type? No.

Is "HEMOTEST" a Document Type? No.
Is ""HEMOTEST"™ a SYNONYM for a Document Type? No.

AUGH! Let"s try a manual look-up...
Again, your LOCAL Title is: CP HEMOTEST

NOTE: Only ACTIVE Titles may be selected...
Select VHA ENTERPRISE STANDARD TITLE: DIALYSIS NOTE

1 found a match of: DIALYSIS NOTE
... OK? Yes// YES

! patch MD*1.0*14 March 2008 Update with new TIU prompts example to reflect TIU field change.
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Ready to map LOCAL Title: CP HEMOTEST to
VHA Enterprise Standard Title: DIALYSIS NOTE.
. OK? Yes// YES
Done.

In the example above, “DIALYSIS NOTE” was selected as the VHA Enterprise Standard Title.
You may use DIALYSIS NOTE as your title, but you are not required to do so. If another title
from the VHA Enterprise Standard Title list is more appropriate for your site, you may select it
from the list.

IFor the high volume procedure(s), there are two steps that you need to do: 1) you must create a
title solely for high volume procedure and 2) you must edit the Technical fields of the note.
Enter a Q (Quit) for Commit Action and Post-signature Code fields. The MD HIGH VOLUME
PROCEDURE SETUP option allows editing of the two technical fields. Note that the title must
be in an inactive status before editing these fields either through TIU or the MD options.

The title that you will create for the high volume procedure will be used strictly for the
administrative closure purpose. Any subsequent note you need to write, use a separate title for it.
The high volume procedure title can be used for one or more procedures. Use the Create CP
Class Document Definitions section to assist you in creating a high volume procedure title(s).

The following steps are used to edit the Technical fields of the note:
Note: Users must have programmer access to edit the technical fields.

Go into the TIU Maintenance Menu.

Select Document Definitions (Manager).

Select Edit Document Definitions.

Expand/Collapse the CLINICAL PROCEDURES CLASS.
Expand/Collapse a selected DOCUMENT CLASS.

Select Detailed Display/Edit of the title.

Select Entry. (Select the entry of the title.)

Select Basics and change the status field to Inactive.

Select Technical Fields enter Quits for both the Commit Action and Post-Signature
Code fields.

10. Select Basics and change the status back to Active.

N~ WLNE

The following is a screen capture of editing the Technical Fields for the High Volume Title:

Title HIGH VOLUME TITLE
Basics Note: Values preceded by * have been inherited
Name: HIGH VOLUME TITLE
VHA Enterprise
Standard Title:
Abbreviation:
Print Name: HIGH VOLUME TITLE

! patch MD*1.0*21 May 2010 - added note title field change for the high volume procedure.
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Type: TITLE
IFN: 764
National
Standard: NO
Status: INACTIVE
Owner: CLINICAL COORDINATOR
In Use: YES
Suppress Visit
Selection: * NO
+ ? Help +, - Next, Previous Screen PS/PL
Basics Technical Fields Find
Items: Seq Mnem MenuTxt Edit Upload Quit

Boilerplate Text Tr

Yy
Select Action: Next Screen// techn
COMMIT ACTION: Q//

Technical Fields

Step 3 - Define Clinical Procedures Class Document Parameters

You need to define a set of document parameters for the new CP Class.

1. Gointo the TIU Maintenance Menu.
2. Select TIU Parameters Menu > Document Parameter Edit.

Note: (Entries in parentheses are recommended values.)

4-10

Parameters: Access the following menu:
TIU IRM Maintenance Menu [TIU IRM MAINTENANCE MENU]
TIU Parameters Menu [TIU SET-UP MENU]
Document Parameter Edit [TIU DOCUMENT PARAMETER EDIT]

Select DOCUMENT DEFINITION: CLINICAL PROCEDURES

CLASS

DOCUMENT DEFINITION: CLINICAL PROCEDURES// <RET>

REQUIRE RELEASE: (NO)
REQUIRE MAS VERIFICATION: (NO)
*REQUIRE AUTHOR TO SIGN: (YES)
ROUTINE PRINT EVENT(S):

STAT PRINT EVENT(S):

MANUAL PRINT AFTER ENTRY: (NO)
ALLOW CHART PRINT OUTSIDE MAS: (YES)
*ALLOW >1 RECORDS PER VISIT: (YES)
ENABLE IRT INTERFACE:

*SUPPRESS DX/CPT ON ENTRY: (NO)
FORCE RESPONSE TO EXPOSURES:

*ASK DX/CPT ON ALL OPT VISITS: (YES)

SEND ALERTS ON ADDENDA:

ORDER

ID ENTRIES BY TITLE:

SEND ALERTS ON NEW

ID ENTRY:

SEND COSIGNATURE ALERT:

EDITOR SET-UP CODE:

IT document is to be uploaded, specify Filing Alert Recipients:
Select FILING ERROR ALERT RECIPIENTS: <identify local recipients as

appropriate>

Now enter the USER CLASSES for which cosignature will be required:
Select USERS REQUIRING COSIGNATURE: <identify local recipients as

appropriate>

Now enter the DIVISIONAL parameters:
Select DIVISION:

CHART COPY PRINTER:

STAT CHART COPY PRINTER:
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Note: You must set parameters marked with an asterisk “*’. If a response is not entered for a
particular parameter, the default value is ‘No’.
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5. About ASU Business Rules and the Role of the
Interpreter

This section describes the suggested Authorization/Subscription Utility (ASU) business rules
that you need to create and it also describes the role of the Interpreter.

Topics discussed in this chapter are:

e How Business Rules Work
e Role of the Interpreter

How Business Rules Work

Business Rules authorize users or groups of users to perform specified actions on documents in
particular statuses. For example, a provider, who is also the Author/Dictator, may view the
note.

To add a business rule:

1. Go into the User Class Management Menu.

2. Select Manage Business Rules.

3. Enter specific words at the appropriate prompts (Status, Action, User Class). These
words are combined to make a business rule.

Example of adding a business rule:

Select SEARCH CATEGORY: DOCUMENT DEFINITION// <RET>
Select DOCUMENT DEFINITION: clinical procedures ~ CLASS
Select Action: Next Screen// a Add Rule

Please Enter a New Business Rule: <RET>

Select DOCUMENT DEFINITION: CLINICAL PROCEDURES// <RET> CLASS
DOCUMENT DEFINITION: CLINICAL PROCEDURES// <RET>
STATUS: unsigned
ACTION: edit
USER CLASS: student
AND FLAG: and
USER ROLE: author/dictator
DESCRIPTION: <RET>
No existing text
Edit? NO// <RET>

The following rule is constructed:
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An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE EDITED by a STUDENT who
is also An AUTHOR/DICTATOR

Suggested Business Rules for CLINICAL PROCEDURES Class

1 A COMPLETED (CLASS) CLINICAL PROCEDURE may BE VIEWED by
A USER

2 An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE EDITED by A
STUDENT who is also An AUTHOR/DICTATOR

3 An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE DELETED by
An AUTHOR/DICTATOR

4 An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED by
An AUTHOR/DICTATOR

5 An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED
by An AUTHOR/DICTATOR

6 An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED
by An EXPECTED COSIGNER

7 An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE PRINTED by
An AUTHOR/DICTATOR

8 An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE PRINTED
by An AUTHOR/DICTATOR

9 An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE EDITED by
An EXPECTED COSIGNER

10 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE EDITED by
An AUTHOR/DICTATOR

11 | An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE PRINTED
by An EXPECTED COSIGNER

12 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE SIGNED by
An AUTHOR/DICTATOR

13 | An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE
COSIGNED by An EXPECTED COSIGNER

14 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED by A
CHIEF, MIS

15 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE DELETED by
A CHIEF, MIS

16 | An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED
by A CHIEF, MIS

17 | An UNCOSIGNED (CLASS) CLINICAL PROCEDURE may BE DELETED
by A CHIEF, MIS

18 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE EDITED by
An EXPECTED COSIGNER

19 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED by
An EXPECTED COSIGNER

20 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE EDITED by A
CLINICAL SERVICE CHIEF
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21 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE VIEWED by A
CLINICAL SERVICE CHIEF

22 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE SIGNED by A
CLINICAL SERVICE CHIEF

23 | An UNSIGNED (CLASS) CLINICAL PROCEDURE may BE SIGNED by
An EXPECTED COSIGNER

24 | An UNDICTATED (CLASS) CLINICAL PROCEDURE may BE EDITED by
An INTERPRETER

25 | An UNDICTATED (CLASS) CLINICAL PROCEDURE may BE VIEWED
by An INTERPRETER

26 | An UNDICTATED (CLASS) CLINICAL PROCEDURE may BE DELETED
by A CHIEF, MIS

Note: Be sure a rule similar to the following exists at the Clinical Documents Class
level.

0 A COMPLETED (CLASS) CLINICAL DOCUMENT may BE LINKED with a
request by A CHIEF, MIS

This rule is not needed at the Clinical Procedures Class level because of inheritance.

Role of the Interpreter

INTERPRETER is a user role that is activated with USR*1*19 to support the Clinical
Procedures Class. Interpreters explain the findings or results of a clinical procedure. In
addition, most interpreters can receive alerts on the procedures that are in “Partial Result” status
and that are ready for interpretation.

Business rules are used to determine what actions an interpreter can perform on a document of a
specified document class, but the interpreters are designated in the Consults application. A
business rule must be defined that allows interpreters to view documents.

Using CPRS Consults, the interpreter selects a procedure request, which has a status of Partial
Results. Using the Consult option “Complete/Update Results,” the interpreter enters the
procedure summary code, the procedure date/time, and the interpretation of the results into the
TIU document. (The “Complete/Update Results” option is only available to interpreters.) Any
encounter related information can also be entered at this time. When finished, the interpreter
electronically signs the note completing the process.

e You can designate a user to be an interpreter by adding the user to any of the following
fields on the Consult Management menu (GMRC MGR). See Step 1 - Setting Up
Consult Services, p. 9-1

- INDIVIDUAL TO NOTIFY
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- SERVICE TEAM TO NOTIFY

- NOTIFICATION BY PT LOCATION

- UPDATE USERS W/O NOTIFICATIONS
- UPDATE TEAMS W/O NOTIFICATIONS
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6. Setting Up Clinical Procedures

This chapter describes how to set up CP procedures, instruments, and system parameters. It is
recommended that you follow these steps in sequential order. Topics discussed in this chapter
include:

e Step 1 — Populate the CP Definition file
e Step 2 — Setting Up Instruments
e Step 3 — Setting Up Procedures
e Step 4 — Setting Up System Parameters

Step 1 - Populate the CP Definition (#702.01) file

You can populate the CP Definition (#702.01) file with names of clinical procedures
automatically by running the INIT"MDPOST routine, and manually by using the procedure edit
screen. Editing the procedures is described in detail later in this chapter.

Before you decide which method to use, review Appendix B — Exported Procedures List, p. 17-1,
for the list of procedures. If the Clinical Application Coordinator (CAC) and the CP package
coordinator decide to use these procedures for the medical center, IRM can run INIT*"MDPOST
to automatically populate the CP Definition file with a list of known procedures. These
procedure definitions are not complete and must be edited using CP Manager to make them work
properly. Additional procedures can also be added using CP Manager.

The application coordinators may initially populate the file manually and then run the
INIT*MDPOST routine at a later time. This routine does not overwrite the existing data in the
CP Definition file; it adds procedures that are not in the current CP Definition file.

All procedures are stored in a subfolder called Unassigned within the Procedures folder. All
procedures are initially tagged inactive. Use CP Manager to activate specific procedures and
associate the procedures with treating specialties.
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Step 2 — Setting Up Instruments
Information on instruments is not complete after instrument information is added during
installation. You must go into CP Manager and enter the necessary fields before the
package will work successfully.
To access CP Manager:

1. Double-click CP Manager on the desktop.

2. Enter your access and verify codes.

3. Click OK. The following main screen is displayed:

li Clinical Procedures Manager

B Instruments
[+-/_ ] Procedures

.48 System Parametars

Figure 6-1
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In most cases, you edit an existing automated instrument. The Mallinckrodt Clinivision,
Olympus Endoworks, GE Medical Systems Muse and Viasys/Sensormedics Vmax automated
device interfaces are exported with Clinical Procedures. You must edit all the automated
instruments that you want to implement with necessary information.

Editing an Automated Instrument

The following list of fields applies to automated instruments:

* indicates fields that must be filled in for an active instrument to work properly.

BOLD indicates fields that are already populated when an automated instrument is exported.

* [Instrument Name

* Printable Name
Description

* M Routine

* Pkg. Code

* Valid Attachment Types

If Bi-Directional Instrument is checked:

*HL7 Inst ID
*HL7 Link

* Notification Mailgroup

* Active

Serial Number (Optional)
Delete When Submitted (Optional)
Default Extension (Optional)
IP Address (Optional)

Port (Optional)

HL7 Unv Svc ID (Optional)
Server Name (Optional)
Share Name (Optional)

Path Name (Optional)
Executable Name (Optional)

To edit an automated instrument:

1. View the list of automated instruments. See Figure 6-2.
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2. Click on an automated instrument. The edit screen is displayed on the right side of the
Clinical Procedures Manager window.

3. Enter the fields that apply to the instrument you selected.

4. Click Save when you are done.

5. Click Print if you want to print an Automated Instrument report. See Printing Reports,

p. 2-4.
il Clinical Procedures Manages M= E3
Fie Tools Help
bEm emaxa aRe . 78
= 5 Chnical Procedures ~ Gegeral
=1 Instruments Ingtiument Name; Prirtable Name:  Motification Mailgoup:
&P Chnivizion |Mu3:e EKG |Harquette LIS
pf - Description: Serial Mumber.
&5 Musce E accice |I'v1u3:e EKG Device Interface | Bctive: [
&P Musze Holter Atachment Processing, Valid Attachment Types:
&P Muse Pacemaker Il Delete when submitted: ™ [ LIMC: [T UUEncode: [+
& Obmpus Dafauh Exl; MAouine:  Phg Cods: b om0 N
| @ ObmpusColonoscoy | [MDHL7M1 ﬁvm - L,
&P Olympus Egd DLL: |

&P Obmpus Egdpeq BirDirectional Capabilities
=9 Opmpuz Endo Ulkz i Diectionad Instrument: [+

40 Obrpuz Entercsco RIS Pot  HL7 InstID: HL7 Unv Sve ID:  HL7 Link:

&= Olyrnpus Ercp
&P Olympus Liver Biops | | [Muse EKG |93[I:||:|=EK|3 |

&7 Olympus Paracente:  — Sepyer Executable:

i ﬁ Eﬂl_',:pus Sigmaidosc Server Mame: Share Mame: Path M ame: Executable Mame:
-] Procedures I I I | —I
48} System Parameters
| | H
User. cPUsER, TWO ) Division: HINES DEV. SUPPORT ' A
Figure 6-2

Here is a list of fields for automated instruments.
General: This section contains general information about the instrument.
Instrument Name: If you are editing an instrument, the name is filled in.

Note: This field must be filled in for an active instrument to work properly. If you are
adding a new instrument that is already supported by CP, do one of the following:
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e If the device is bi-directional, you can enter a name of your own choice (3-30
characters), such as Muse EKG (Tampa). The name does not have to be the
vendor’s name.

e If the device is uni-directional, you need to enter a CP defined name. In this
case, you can contact TSO or NVS for the correct instrument name.

If you are adding a new instrument (bi-directional or uni-directional) that is not supported
by CP, then you must enter a NOIS/Remedy help ticket. Keep in mind that adding
unsupported instruments is a complex task and may cause some image quality problems.

Printable Name: Enter a name for the instrument report (3 to 30 characters). You can
use the same name as the instrument name. This name is used as the printable name on
reports. Must be filled in for an active instrument to work properly.

Notification Mailgroup: Enter the name of a local VistA mailgroup that contains a list
of people, who will be notified if a problem arises with this automated instrument.

CP also exports a mailgroup called “MD DEVICE ERRORS” that can be used to
populate this field. Enter MD and the field fills in with “MD DEVICE ERRORS’. The
coordinator of this group is assigned during package installation. Must be filled in for an
active instrument to work properly.

Description: Enter a description of the automated instrument (1-50 characters).
Optional.

Serial Number: Enter the serial number of the automated instrument (1-50 characters).
The serial number is used for documentation purposes. Optional.

Active: Select this option if you want to make the instrument active and able to transmit
results. Do not select if the package coordinator wants to prevent data from a specific
automated instrument from being processed. A package coordinator may want to enter
the basic information for an automated instrument and not make it active. Must be
selected to make this instrument active.

Attachment Processing: This section contains information about attachments.

Delete when Submitted: Select this option if the medical center does not want to store a
duplicate report outside of Imaging, or if the vendor wants to delete files because of
storage issues. The vendor determines whether or not the report files can be deleted.
This information is found in the vendor’s setup instructions. Optional.

Default Ext.: Enter a default file extension that is exported by the vendor, such as .html,
Jpg, and .pdf. This information should be obtained from the vendor or will be exported
with future patches. Optional.
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M Routine: Indicates the M routine used to process the HL7 message from the
automated instrument (1-8 characters). Enter an M routine if the site is entering a new
device. The routine must have a namespace of MDHL7* for any nationally released
interfaces. This field also is automatically populated when an instrument interface patch
is installed. If a local M routine is developed, use the local namespace. Refer to
Appendix C — Instrument Processing Routines, p. 18-1, for a list of appropriate M
routines for each instrument. Must be filled in for an active instrument to work properly.

Pkg. Code: Indicates which package is to process the instrument results. Must be filled
in for an active instrument to work properly.

Medicine: Select if your study data is stored in the Medicine package. If a site is
currently running Medicine and has an instrument used for Medicine, you
can send the result to Medicine by selecting this field.

CPV1.0 Select if your study data is stored as a final report (in the format of an
Imaging document) in Clinical Procedures.

Valid Attachment Types: Data types let CP know what kind of data output to expect
from the automated instrument so that the data can be processed by the interface routines.
The vendor setup instructions provide this information, or Clinical Procedures
automatically exports this information. Must be filled in for an active instrument to work

properly.
Here is a list of valid attachment types:

UNC (Universal Naming Convention or Uniform Naming Convention) - A PC format for
specifying the location of resources on a local-area network (LAN).

UUENCODE (Unix-to-Unix ENCODE) - A set of algorithms for converting files into a set
of ASCII characters that can be transmitted over a network.

Text - Text stored as ASCII codes.
XML (eXtensible Markup Language) - A specification developed by the World Wide Web
Consortium (W3C), the organization that sets standards for the web. XML is a pared-down

version of SGML. Designed especially for Web documents.

URL (Uniform Resource Locator) - The global address of documents and other resources on
the World Wide Web.

XMS - An XML Style Sheet.

DLL (Dynamic Link Library) - A library of executable functions or data that can be used by
a Windows application.
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Bi-Directional Capabilities: This section contains specifics on the bi-directional capabilities of
the instrument.

Bi-Directional Instrument: Select this option if this instrument supports a bi-directional
interface.

IP Address: Enter the IP address for the instrument (7-15 characters). This field is for
documentation purposes only. Refer to Chapter 10 — Setting Up HL7 Parameters, p. 12-1, for
more information. Optional.

Port: Enter the port number for the instrument (a number between 1000 and 99999). This
field is for documentation purposes only. Refer to Chapter 10 — Setting Up HL7 Parameters,
p. 12-1, for more information. Optional.

HL7 Inst ID: Enter the name of the actual device as provided by the vendor. This field is
used to ID the device (3-30 characters). You can contact TSO or NVS for the correct ID.
Must be filled in for an active instrument to work properly.

HL7 Unv Svc ID: This field defines what type of procedure the device can perform if the
device can perform more than one procedure (1-48 characters). Optional.

HL7 Link: There is one unique link for each instrument. Select the appropriate link to the
instrument from the dropdown list. Must be filled in for an active instrument to work
properly. (This must be filled in with the outbound link that you have created for the device.
For example, MCAR OLY could be entered for an Olympus device.)

Server Executable: The following fields make up the path for the automated instrument server
(http://servername/servershare/serverpath/server.exe). Some devices do not produce reports that
can be saved. Enter these fields if you want to capture a report from that type of device.

Server Name: The network name of the automated instrument (1-30 characters).

Server Share: The name of the share drive on the automated instrument server (1-30
characters).

Server Path: The full directory path on the automated instrument share (1-150 characters).
Server Executable: The name of the executable that produces the report on the automated
instrument (1-30 characters). Browse to find the path where the server.exe program resides.
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Adding an Automated Instrument

If a site has an instrument that needs to interface with CP, and that instrument is not exported
with the Clinical Procedures package, you need to add the instrument. Make sure that CP
supports the instrument interface. (The Mallinckrodt Clinivision, Olympus Endoworks, GE
Medical Systems Muse and Viasys/Sensormedics Vmax automated device interfaces are
exported with Clinical Procedures.) You can also find an updated list of supported devices on the
CP Sharepoint at
https://vaww.oed.portal.va.gov/projects/Clinical_Procedures/Device%20Settings/Forms/Allltem

S.aspx

Click Medical Device Interfaces on the left navigation bar, then click About Medical
Interfaces.

A warning screen displays when you attempt to add a new instrument (Figure 6-3). This
warning screen informs you that you should make sure CP supports the instrument interface you
are attempting to add.

Warning EI

Maotice: If vou choose to add an unsupported instrument,
' be aware that image quality and database integrity may be
L

affected.

Please contact EYS if wou would like help in developing a
supported inkerface,

Figure 6-3

If you are adding a new instrument (bi-directional or uni-directional) that is not supported by CP,
then you can use the New Instrument Request form, which is also located on the CP website at
http://vista.med.va.gov/ClinicalSpecialties/clinproc/. You can also check p. 18-1 for a list of
instruments. Keep in mind that adding unsupported instruments is a complex task and may cause
some image quality problems.

In most cases, you can edit an existing automated instrument instead of adding a new one
because several automated instruments are installed with Clinical Procedures. To view the
names of devices, click the Instruments folder. A list of automated instruments is displayed on
the left side of the Clinical Procedures Manager window (Figure 6-4).

! patch MD*1.0*4 September 2006 Add instrument warning added.
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& Musze Holter

& Muse Pacemak.er EI
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&5 Olympuz Egd
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= Okmpuz Endo Ulris
& Ohmpus Enteroscog
&9 Olympusz Ecp

&P Olympus Liver Biops
& Olympus Paracente:
& Olympus Sigmoidosc

e
(-] Procedures
b System Parameters
4] | ©
[User cPUSER, WD ) |Divisior: HINES DEV. SUPPORT Z

Figure 6-4

Indicates active instruments:; ‘=
Indicates non-active instruments; &=

1. Select File > New > Instrument. The New Instrument screen is displayed.

2. Enter a name that can be used to identify the automated instrument. If you are adding a
new instrument that is already supported by CP, do one of the following:

e If the device is bi-directional, you can enter a name of your own choice (3-30
characters), such as Muse EKG (Tampa). The name does not have to be the
vendor’s name.

e If the device is uni-directional, enter a CP defined name. In this case, you can
contact TSO or NVS for the correct instrument name.

If you are adding a new instrument (bi-directional or uni-directional) that is not supported by CP,
then you must you must enter a NOIS/Remedy help ticket. Keep in mind that adding
unsupported instruments is a complex task and may cause some image quality problems.
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This field must be filled in for an active instrument to work properly.

3. Click OK. The Edit screen is displayed. Figure 6-5 is the edit screen for automated
instruments. The Automated Instrument Name that you just entered is displayed.

4. Enter data for each field as applicable. Refer to Editing an Automated Instrument, p. 6-3,
for detailed field descriptions.

5. Click Save when you are done.

6. Click Print if you want to print an Automated Instrument report. See Printing Reports,

p. 2-4.

ECIinical Procedures Manager
Fie Tools Help

OED Y RBX&G Qe | 7E

=+ Chnical Frocedures — Geperal

=+ Ingtruments |nstrument M ame: Printable Name:  Motification Mailgroup:

& Chnivizion |Mus:e EkG |Harquette M5
&5 Muse Description: Serial Number.
& Muse Frrcise |I‘--1u3:e EKG Device IMferface | Active:  [F
&P Muse Holter Attachment Processing: Walid Attachrment Types:
&P Muse Pacemaker El  Delete when subrmitted: [ LIMC: [ UUEncode: v
& Obmpus Defaul Ext: M Floutine: ___ Pkg Code: BEER N
&9 Olmpus Colonoscoy IMDHL?I'-H I#m 0 LRL: [ =MS5: »
&P Olympus Egd : DLL: r
&P Olympus Egdpeg Bi-Directional Capabilitie:
= ghlmpus E“‘d':' Utz BiDiectiondl Instrument: @
P nt ,
B O b 1P Address Pot__ HL7InD:  HL7UnvSvelD:  HL7 Link
&9 Olpmous Liver Biops | | [Muse EKG 93000-EKG |
& Olpmpus Paracente:  — Server Executable:
€5 Olmpus Sigmoidosc Server Mame: Share Mame: Path Mame: Executable Mame:
- | | | |

[#-_] Procedures

i @ Swstem Parameters

1 | N
\User CPUSER, TWO (] IDivision: HINES DEV. SUPPORT 7
Figure 6-5
6-10 Clinical Procedures V. 1.0 April 2004

Implementation Guide



Setting Up Clinical Procedures

Additional Instrument Parameters

Two additional instrument parameters are now available in CP which can be set using their
respective VistA menu options.

The CP — DICOM Interoperability parameter will improves interoperability between Clinical
Procedures and VistA Imaging CPRS Consult Request Tracking DICOM. There are three
capabilities:

First, the VistA Imaging consult accession number sss-GMR-nnnnnnnn can be used for the
Clinical Procedures Instrument Order Number.

Second, the timing of the DICOM Modality Worklist creation is changed from order release to
check-in, making it much more useful.

Third, the VistA Imaging HL7 message body can be used instead of the CP HL7 message body.
(The VistA Imaging HL7 has much more information than the CP HL7.)

Note: This is for bidirectional CP instruments only. Also, the CP must have an entry in the
CLINICAL SPECIALTY DICOM & HLY7 file (#2006.5831) to have DICOM Modality Worklist
and HL7.

The option CP - DICOM Interoperability [MD DICOM] resides on the CP Coordinator [MD
COORDINATOR] menu:

MD COORDINATOR CP Coordinator Menu

Auto Study Check-In Setup

CP - DICOM Interoperability
High Volume Procedure Setup
Keep Consult Open for CART-CL

Select CP Coordinator Menu Option: CP - DICOM Interoperability

Select CP INSTRUMENT NAME: OLYMPUS EGD {554EC814-50A9-8389-1331-
CE60DB3CD2FF}

CP - DICOM INTEROPERABILITY: ?
Select special VistA Imaging processing
Choose from:
0 No special action
1 Use VistA Imaging accession humber sss-GMR-nnnnnnnn
2 Use VistA Imaging HL7 instead of CP's HL7
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The ‘CONSULT KEEP OPEN’ parameter is intended for CART-CL interoperability:

This Clinical Procedures Uni-directional Configuration flag 'CONSULT KEEP OPEN' provides
the following functionality:

The CP procedure is automatically placed in Completed status after the HL7 message is sent,
thus preventing an "inbound” HL7 message containing the test results from being sent back to
the CPRS Consult Note.

The physician can then edit the Consult Note by manually pasting in data from a test result
reporting system to complete the Consult.

This modification is beneficial for users of reporting systems-such as the Clinical Assessment,
Reporting, and Tracking System for Cardiac Catheterization Laboratories (CART-CL)
application-who do not want the test results from the medical instrument to populate the CPRS
Consult Note, but prefer to manually paste the test results from the reporting system into the
Consult Note.

The option “Keep Consult Open for CART-CL’ [MD CARTCL] resides on the CP Coordinator
[MD COORDINATOR] menu:

MD COORDINATOR CP Coordinator Menu

Auto Study Check-In Setup

CP - DICOM Interoperability
High Volume Procedure Setup
Keep Consult Open for CART-CL

Select CP Coordinator Menu Option: keep Consult Open for CART-CL

Select CP INSTRUMENT NAME: IVAULT ECHO {48E0112B-335C-4C78-9EBA-
D4362EEE38D1}

CONSULT KEEP OPEN: ?
Enter Yes to keep consult note open or No to close consult note.
Choose from:
0 No
1 Yes

Using the Instrument Analyzer

Use the Instrument Analyzer to see if an automated instrument is ready to use with CP.

6-12 Clinical Procedures V. 1.0 April 2004
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=

Select Tools > Instrument Analyzer.

2. Select the instrument that you want to analyze. Click Analyze. A window similar to
Figure 6-6 is displayed. This window indicates the ready status of the instrument and
lists other information as well.

Interface Analyzer |
[natrument Mame: Muze ECG ﬂ
Print M arme:

Feady Status: Fail

Mo Print Mame Defined.

Device iz zet to Inactive.

Mo kail Group Defined in the ingtrument file.
Mo Processing routing indicated.

Mo HLY Instrument 1D,

Mo Walid Attachment Types indicated.

Errirk | :

Figure 6-6

e Ready Status - Pass or Fail. If the Ready Status is Fail, a list of missing fields for that
automated instrument is displayed.

e If an Imaging share directory has not been configured, the following message is
displayed “No Imaging Share indicated in the System Parameters.”

e |If the M Routine (processing routine) is not in the MD or MC namespace, a warning is
displayed indicating that the M Routine is not in the package namespace.

3. Click Print or Close.
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Step 3 — Setting Up Procedures

Information on procedures is not complete after populating the CP Definition file. You must go
into CP Manager and enter the necessary fields before the package will work successfully.

If the INIT*"MDPOST routine was run, a limited number of exported procedures are stored in a
subfolder called Unassigned within the Procedures folder. If the INIT*"MDPOST routine was

not run, then you need to add new procedures. Since all procedures are initially inactive, you
need to activate existing procedures and associate them with treating specialties.

Editing a Procedure
If the procedures have been exported, then you can edit them as needed. Using CP Manager,
you must move each procedure that you want to activate from the Unassigned folder to a treating

specialty folder.

e Double-click the procedure. Now you can edit the procedure, complete the necessary
fields, and make the procedure active.

e To activate the procedure, be sure to select the Active field, and then fill in the following
fields to ensure that the procedure works properly

Treating Specialty

TIU Note Title

Hospital Location
To edit a procedure:

1. View the list of procedures. See Figure 6-7.

2. Click a procedure name. The edit screen is displayed on the right side of the Clinical
Procedures Manager window.

3. Enter the fields as applicable.

'Note: Make sure to set the Processing Application field to HEMODIALYSIS for
Hemodialysis procedures.

4. Click Save when you are done.

! patch MD*1.0*6 May 2008 Processing Application field added.
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5. If you selected a different treating specialty folder, a confirmation message is displayed.
Click OK to confirm that the procedure is in the correct treating specialty folder.

6. Click Print if you want to print a Procedure report. See Printing Reports, p. 2-4.

Note: A procedure can only be deleted through the main menu bar. Refer to the section Deleting
an Automated Instrument or Procedure, p. 2-3, for more information. If a procedure has been
assigned through Consults, it cannot be deleted.

Elinical Procedures Manager =] E3
File Tools Help
BB oEXS AWL Y| ?E |
[ ) GEneraISurgery;I — General: Allowable |nstruments:
-] Gensrallcute M Procedure Name: [ mm: E‘ypeytension -
= HEMODIALYSIS, REFEATED EVAL. ive: S BnEls
& Hemotoogyone | tellvz |0 ] 4XI0M Sensis (BiDirectional]
Agpiration Treating Specialty: [] &4I0M Sensis (Diag. Cor. Cat
[] &10M Sensis (EP Study]
IHEMDTDLDGWDNEDLDGY ; AFIOM Sengis [Ped. Card. Int
TIU Mote Title: [ Ax10M Senzis (Ped. Cor. Catt
[] CATHCOR
|PROCEDURE NOTE [ CATHCOR (BiDirectional)
Hospital Location: [] CB-MORTARA
[] CE-MORTARA [EKG)
[PFT La C] CB-MORTARA [Haher)
) ) ) [] CB-MORTARA [Stress)
Auto Submit To Yistd Imaging: - L1 ELINMSION o
] Require External Datai I~ z Elallrill\ﬂglDN[B"D"ECt'Dna”
Iw Push External Attachment Directory: [ COLLING (Bi-Directional)
N I [ Compumedics
I Ther. 1 8.' I : - —I L] Compurnedics [Actigraphy]
Processing Application: [ Compumedics [Bi-Directional]
> [] Compumedics [CPAF Titratior
IHEMDDMLYSB J ; Compumedics [Diagnostic PS
3 [| Compumedics [MSLT)
[ Compumedics [Mw/T]
- Subcut/im ] Compumedics (Splt-night PSE
-[Il Trare. Blood ] DMS
-{Hl) Trans. Indwe (] DMS [Bi-Directional)
[Il Trare. Therz = gmg [E'ELE]
(Il Trarsfusion ] OMS EEP] !
(Il Weripurcturs ] ENDOSOFT
----- (2 High Intensity Ge (] ENDOSOFT [Bi-Directional]
..... (23 Homeless Cwt/T | GAMBRO_ExALIS
_| i-Directi
_____ [ Hospice [ GAMBRO_EXALIS [Bi-Direct
] ] GCARE
-] Intermediate Med [] GCARE [Bi-Directional)
4 | | 3 [1 GCARE [Colonoscopy] LI
User: EUSTAMANTE, AL {) |Division: HINES 15C [ y

1Figure 6-7

Here is a list of fields for Procedures.
General: This section contains general information about the procedure.

Procedure Name: Enter a name used to uniquely identify the procedure (3-30 characters). It
is recommended that you enter the name in uppercase, such as PACEMAKER FOLLOWUP.

After you complete the edits, if you entered the name in upper case, the procedure name that
you just entered is displayed in title case, Pacemaker Followup, (the first letter of every word

! patch MD*1.0*6 May 2008 Processing Application field added.
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is capitalized), in the left side of the CP Manager window. See Figure 6-6.

Active: Select if you want the procedure to be mapped to Consults. Only active procedures
can be selected and linked to the Consults package. Be sure to fill in the Treating Specialty,
TIU Note Title, and Hospital Locations fields. Do not select if you do not want procedures to
display. Must be selected to make this procedure active.

Treating Specialty: Enter at least two letters of a treating specialty, such as CA for
CARDIOLOGY, and then click the down arrow to select an appropriate match from the list.
This list comes from the Treating Specialty (#45.7) file. Must be filled in for an active
procedure to work properly.

TIU Note Title: Enter at least two letters of a TIU Note Title, such as CP CARD for CP
CARDIOLOGY NOTE or CARD for CARDIOLOGY, and then click the down arrow to
select an appropriate match from the list, which comes from the 8925.1 file. This title must
be in the CLINICAL PROCEDURES CLASS. Must be filled in for an active procedure to
work properly.

'Hospital Location: Enter at least two letters of a hospital location, such as CA for Cardiac
Clinic, and then click the down arrow to select an appropriate match from the list, which
comes from the #44 file. The Hospital Location file is the location where the workload credit
for the procedure is tracked and is needed so CPRS can display the appropriate encounter
form when prompted. Must be filled in for an active procedure to work properly.

You can enter a COUNT or NON-COUNT clinic for the hospital location.

e A COUNT clinic captures workload. Patients must be checked in and checked out
and an encounter form must be completed in order to collect workload.

e A NON-COUNT clinic is used only for scheduling purposes and not for workload
reporting.

There are three options available for setting up your clinics. The appropriate option for your
site depends on how you currently do business and should be discussed with your project
implementation manager.

e COUNT clinic for scheduling purposes / NON-COUNT clinic for CP User. Patient
must be checked in/out and encounter form completed on the scheduled appointment.
CP User appointment will not collect workload.

e NON-COUNT clinic for scheduling purposes / COUNT clinic for CP User.
Appointment in scheduling package does not need to be checked in/out, nor does an

! patch MD*1.0*4 September 2006 Wording for Count/Non-count clinic modified.
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encounter form need to be completed for the appointment. The check in/out and
encounter form must be completed for the appointment created through CP User.

e COUNT clinic for scheduling purposes that passes over to CP User. Patient must be
checked in/out and encounter form must be completed. Note, however, that if you use
Appointment Manager to check in the patient, you may have to wait up to thirty
minutes before you can check-in the patient to CP. During the thirty-minute
timeframe, the Patient Care Encounter (PCE) application establishes the visit date. (If
you use the Scheduling application to capture workload, make sure that the clinic
location is the same as the default location in the Hospital Location field.)

Auto Submit to VistA Imaging: Select if a procedure is processed by a bi-directional
instrument and additional data does not need to be matched. The study is automatically
submitted to VISTA Imaging. If this field is not selected, the study will be in the Ready to
Complete status. Optional.

Require External Data: Select if you want this procedure to allow external attachments.
For example, you might want to attach an independent report from a VA or non-VA health
care facility. If you want to manually select external attachments, you must select this field.

Be sure the Allow Non-Instrument Attachments checkbox is selected in CP Manager >
System Parameters. There is no default for this field.

External Attachment Directory: If you select Require External Data, enter the path where
the data is located, or browse to locate a directory (3-150 characters). There is no default on
this field. You can locate any directory on the LAN. This is the directory that CP User
accesses to find attachments. This directory must be a network share directory that the VistA
Imaging Background Processor can access.

'Processing Application: Set the Processing Application field to HEMODIALYSIS for
Hemodialysis procedures. Any other CP procedures will default to the Default setting, so you
do NOT need to set the field.

Allowable Instruments: Select each automated instrument that provides results for this
procedure. You can select more than one instrument for a procedure. If you only want to use
external attachments, do not select any instruments.

You can select both Allowable Instruments and Require External Data. For example, you
can have a pathology report from an endoscopy and you can attach the report to the
procedure.

! patch MD*1.0*6 May 2008 Processing Application field added.
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Processed Results: This field is a flag which indicates whether a final result, multiple
results, or cumulative result is associated with this procedure. This field is not accessible
using the CP Manager application. It must be edited using File Manager.

’Note: If the site does not have a multiple result instrument, NO setup needs
to be made. CP automatically defaults to using '0" for Final Result. If
the site has a multiple result instrument, the site can select either '1'
for Multiple Results which allows creation of a new TIU note for each result
sent back or a '2' for Cumulative Result which allows the multiple result
device to continuously send results back to the same TIU note. If the site
needs to enter the PROCESSED RESULT field, the user will have to use File
Manager to edit the field in the CP DEFINITION File (#702.01).

L patch MD*1.0*11 June 2009 Processed Results field added.
2 patch MD*1.0*11 June 2009 Processed Results field added.
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Adding a Procedure

Before you add a procedure, you can check to see if an appropriated titled procedure already
exists that meets your needs. To view the names of procedures, select Procedures and then the
appropriate treating specialty folder. A list of procedures is displayed. See Figure 6-8.
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Figure 6-8
& - 1dentifies an active procedure
M - |dentifies a inactive procedure
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If you decide that you do need to add a procedure, follow these instructions:

1.

2.

Select File > New > Procedure.

Enter the name of the procedure that you want to add. It is recommended that you enter
the name in uppercase with a minimum of 3 characters and a maximum of 30 characters.

Click OK. The Edit screen is displayed. Figure 6-9 is the edit screen for procedures. The
Procedure Name that you just entered is displayed in the left side of the CP Manager
window in the Unassigned folder.

Enter data for each field as applicable. Refer to Editing a Procedure, p. 6-14, for detailed
field descriptions.

Click Save when you are done. After you complete the edits, if you entered the name in
upper case, the procedure name that you just entered is displayed in title case.

Click OK. The new procedure appears in the list on the left side of the CP Manager
window. Check that the procedure is placed in the correct treating specialty folder.

Click Print if you want to print a Procedure report. See Printing Reports, p. 2-4.
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! patch MD*1.0*6 May 2008 Processing Application field added.
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The following is a screen capture of using File Manager to edit the PROCESSED RESULT
field in the CP Definition file (#702.01).

>D P~DI
VA FileMan 22.0

Select OPTION: 1 ENTER OR EDIT FILE ENTRIES

INPUT TO WHAT FILE: CP TRANSACTION// 702.01 CP DEFINITION
(310 entries)
EDIT WHICH FIELD: ALL// PROCESS
1 PROCESSED RESULT
2  PROCESSING APPLICATION
CHOOSE 1-2: 1 PROCESSED RESULT
THEN EDIT FIELD:

Select CP DEFINITION NAME: PUL
1 PULMONARY ARTERY CATHETER
2 PULMONARY ENDOSCOPY
3 PULMONARY FUNCTION INTERPRET
4 PULMONARY FUNCTION TEST
5 PULMONARY PROCEDURES
Press <RETURN> to see more, "~ to exit this list, OR
CHOOSE 1-5: 5 PULMONARY PROCEDURES
PROCESSED RESULT: ?
Enter the processed result.
Choose from:

0 Final Result
1 Multiple Results
2 Cumulative Result

PROCESSED RESULT: 1 Multiple Results

Select CP DEFINITION NAME:

! patch MD*1.0*11 June 2009 Editing the PROCESSED RESULT field of CP Definition file (#702.01).
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